
Presto! PhotoAlbum Context Help

Enjoy your photos with an electronic album in Presto! PhotoAlbum!! 
You will get simple explanations about the functions in Presto! PhotoAlbum from the on-line help. For 
more detailed information, please refer to your User's Manual.

Presto! PhotoAlbum



Starting Presto! PhotoAlbum

When you start Presto! PhotoAlbum, the opening screen appears with several buttons for 
your selection.

Note:

If you did not use “Typical” setup when installing the software, to utilize all the attached 
libraries of album template, frame, texture, ornament, etc., please insert the Presto! 
PhotoAlbum CD-ROM into your CD-ROM drive before running the software.

Related topics:

Opening an Album
Creating a New Album
Enjoying an Album



Opening an Album

A pre-existing album can be recalled for editing when you want to add or remove some 
photos in it or make some changes to the pages.
To recall an existing album for editing, you should select the EDIT button in the opening 
screen. When the Select An Album dialog box appears, locate the album you want to edit.
1. Select the category that the album you want to locate belongs to from the category icons

at the left of the dialog box.
2. From the shrunken copies of the albums, select the one you want to recall.

The lower part of the dialog box displays the information about the page number, last 
saved date and the description of the album. You may click the Play button to listen to 
the sound or music attached to the album, if any. Drag the album icon to the trash-can if 
you want to delete an album.

3. Click on the [OK] button.



Creating a New Album

Click the CREATE button in the opening screen for creating a new album. The screen 
changes with the following buttons:

When you want to create a new album, you should define the book style of the album; that 
is, the appearance of the album. The appearance of an album indicates the format of the 
book, the kind of rings fastening the pages, etc.

Related Topics:
Using an Album Template
Defining New Album Format



Using an Album Template

Presto! PhotoAlbum provides some sample albums for using as predefined templates of book
styles. Also, if you have composed an album and saved it in your disk before, you can use its
format as a template for creating a new album.
The format of the selected album will be copied with empty photo cells (frames) for entering 
new photos.
To compose your own album, you may select one of the predefined templates or pre-existing
albums and change its contents as you wish, or customize a totally new album by yourself.
To select a predefined template or pre-existing album:
1. Click the TEMPLATE button from the CREATE options. A dialog box appears for locating 

an album used as template:
2. Select the category that the album you want to locate belongs to from the category icons

at the left of the dialog box.
3. From the shrunken copies of the albums, select the one you like or closest to your 

expectation.
The lower part of the dialog box displays the information about the page number, last 
saved date and the description of the album. You may click the Play button to listen to 
the sound or music attached to the album, if any. Drag the album icon to the trash-can if 
you want to delete an album.

4. Click on the [OK] button or double click on the selected album icon.



Defining New Album Format

If you want to create a totally new album without using any predefined template or pre-
existing album format, click on the CUSTOM button from the CREATE options. A dialog box 
appears for selecting the book style.
1. When the Book Style button is depressed, you may select a book style for the new album.
2. Click on the Ring Style button to select a ring style for fastening the pages in the album.
3. Click on the Background button to select a background pattern for the desktop around the 

album.
3. Click on the Preview button to display a preview according to your selection in the 

preview window.
4. Click the OK button.



Editing the Albums

After you have specified a book style for creating a new album, or selected an existing 
album for editing, the editing screen will appear with the first page of the album.

Related Topics:
Menus and Commands
Loading the Photos
Using the Tools
Decorating the Album



Menus and Commands

There are several pull-down menus located on the menu bar. Each menu contains a list of 
commands to execute special functions for image processing.
Choose a menu from the following list to view the command function under it.

Album
Page
Photo
View
Help



Album Menu

The following commands are included in the Album menu:
Put All Photos
Save
Save As
Deliver
Print
Mute
Properties
Restart
Exit



Put All Photos

You can add all the photos, by the alphabetical order of their file names, in the Photo Viewer 
into the album at one time with one simple step. After you have defined the frame style(s) 
for all the pages, open the Album menu and select the Put All Photos command. The photos 
will be inserted automatically and the number of pages will match that of the photos 
according to the format of album.
Note:

If your Presto! PhotoAlbum is a bundled version, the maximum page number for an album 
may be limited to 12.



Save

After an album has been created, it should be stored for later usage and editing.
Open the Album menu and select the Save command. The album is saved with its name and
category specified in the Album Information dialog box.



Save As

If you have not specified a name and category for the album or you want to save the album 
with another name or category, you may choose the Save As command in the Album menu. 
The Album Information dialog box will be invoked for your specification to the album, and 
the album will be saved immediately after you click on [OK].



Deliver

After an album is edited complete, you may share the album with others or deliver it by 
diskettes to playback with Presto! PhotoAlbum’s playback program on another computer. The
For Playback option of Deliver command can convert the current album to an execution file 
with all the files needed for independent playback by the playback program.
The For Internet option of Deliver command can convert the album into HTML format and 
provide all the files needed for playing back on an Internet browser so you can share the 
album with remote users. 
To deliver an album:
1. In the editing screen, open the Album menu and select the Deliver command.
2. Choose the For Playback or For Internet option from the pop-up sub-menu.
3. A message box appears containing the description of the option. Read the message and 

click on [OK] to continue.
4. When the Choose Directory dialog box appears, locate the directory you want to send the

album to, or enter a new folder name to hold all the files needed for playing back.
5. Click on the [OK] button.
A new folder containing all the files needed for playing back will be created with the name 
you typed. If you have selected the For Playback option, you may execute the .EXE file 
directly to playback the album. If you have used the For Internet option, the file named 
DEFAULT.HTM (or VIEWER.HTM) is the HTML format file you should use for enjoying the 
album.

Related Topic:

Sharing the Album on Internet



Print

The Print command under the Album menu provides users with different options for printing 
and output formats. To print a page:
1. Open the Album menu and choose Print. The Print dialog box appears.

In default, the Printer tab is active. The information about the current printer, port 
configuration and page orientation setups are displayed in the upper part of the dialog 
box. These can only be changed through the commands in the Setup dialog box. If you 
want to change any of these items, click on [Setup] at the bottom.

2. Enter the number of copies you want to print in the Copies text box.
3. Select the orientation of the paper as portrait or landscape.
4. The Set Margin section allows you to set the top and left margins. You may also choose to

print the page horizontally or vertically on the middle of a page.
You can change the position’s coordinates and units from the Unit pull down list box.

5. In the Quality section, select Normal, Medium or High option you want to print with. The 
higher printing quality, the slower the printing speed.
The resolution for Normal printing is 640x480 pixels printed with album rings, or 600x400
pixels without rings. The printing resolution for Medium quality is 1200x800 without 
album rings, and that for High quality 2400x1600.

6. If you have selected Normal resolution, you may decide whether to print the album rings 
by enabling or disabling the Ring option.

7. If you want to rescale the page while printing, select the Rescale tab to make related 
setting.

8. Click on the Fit In Page check box if you want to rescale the page in relation to the size of
the paper used.
If you need to change the size of the paper, select the correct size from the Paper Size 
list box.

9. You can set the scaling ratio by entering its size in the Target Image section or by 
entering the X (horizontal ratio) and Y (vertical ratio) values in the Rescale Factor 
section. You can also specify the scaling ratio by dragging the slider between the 10% 
and maximum rescale proportion indicated.
If you have enabled the Keep Ratio option, you can enter either the width or the height of
the rescaled page. The software will automatically determine the other value for you.
If you have disabled the Keep Ratio option, you have to enter both the width and height 
to rescale the page. If the values you enter are not proportional, the rescaled page will 
be distorted.

10.Enter the horizontal and vertical resolutions of printing in the Resolution text boxes.
11.Click on the [OK] button to print; click on the [Cancel] button to abandon all the changes 

and return to the editing screen without printing.



Mute

Executing the Mute command in the Album menu turns on or off the sound effect generated 
from operation in the software. This function is the same as clicking the Sound Effect On/Off 
button in the opening screen.
When a check mark "" appears at the left of the command, the sound effect is turneded off.



Properties

When you select the Properties command from the Album menu, the Album Information 
dialog box appears.
1. Enter a name for the new album in the Album Name text box.
2. Select a category that the new album should belong to in the Album Category pull-down 

list, or type in a new category name directly.
The default category for holding your album is “My Album.” You may name a new 
category according to the content of your album.

3. In the Information text box, you may type in the description about the new album for 
identifying the content in it.

4. If you want to add some music to the album so that a background music can be played 

when you are enjoying the album, click on the Music  button.
A dialog box appears for selecting a wave or midi file to attach to the album. Locate the 
file and click on [OK] to attach the music.

5. If you want to record some sound effects or a narration about the album, click on the 

Record  button. When the Audio Format dialog box appears, set the sound elements 
for the format of your sound file.
After you click [OK], you may start to record with your microphone. When you finish 
recording, click the Record button again to stop recording.

You may click the Play  button to listen to the result of recording.
6. Click on the [OK] button to save the album information.



Restart

The Restart command enables you to go back to the opening screen aroused by Presto! 
PhotoAlbum program.



Exit

The Exit command enables you to quit the software.



Page Menu

The editing commands under the Page menu are used for changing the pages.
New a Blank Page
Repeat Current Page
Copy Page
Insert Page
Delete Page
Clear Page
Next Page
Previous Page
Cover Page
Last Page
Goto/Find Page
Wall Paper
Background Music



New a Blank Page

The New a Blank Page command allows you to insert a blank page after the current page. To 
add a new page after the current page, open the Page menu and select New a Blank Page.



Repeat Current Page

The Repeat Current Page function enables you to insert a new page after the current page 
and reproduce the content of current page onto it. When you execute the Repeat Current 
Page command, a new page appears on screen containing the same content as that in the 
page before executing the command.



Copy Page

The Copy Page function enables you to make a copy of the current page and place it on the 
Windows clipboard. The original page is unaffected by the Copy Page command. You could 
use the Insert Page command to move the content last copied on the clipboard to another 
page. Only the last copied content resides in the clipboard. To copy a page:
1. Turn to the page you want to copy its content.
2. Open the Page menu, and click on the Copy Page command. A copy of current page then

resides in the clipboard.



Insert Page

The Insert Page command can insert a new page before the current page and place the 
content of a page on Windows clipboard onto it. The command works only when there is 
already a content in the clipboard. To insert a new page with clipboard content, open the 
Page menu and select Insert Page.



Delete Page

The Delete Page command permanently removes the content of the current page and the 
page itself. After executing the Delete Page command, the current page is removed and the 
next page appears automatically.



Clear Page

The Clear Page command removes the content of the current page, including the ornament 
objects and the photos with their frames and shadows, but the page itself still remains.



Next Page

The Next Page command can locate the page after the current one in the album and display 
its content in the album page.



Previous Page 

The Previous Page command can locate the page before the current one in the album and 
display its content in the album page.



Cover Page

The Cover Page command can locate the first page in the album and display its content in 
the album page.



Last Page

The Last Page command can locate the last page in the album and display its content in the 
album page.



Goto/Find Page

The Goto/Find Page command can locate any page you specify its page number or the page 
containing the photo with the specific text string you stated in the Information option of its 
Properties dialog box, and display its content in the album page.
To execute execute this command:
1. Select the Goto/Find Page command from the Page menu. The Go To dialog box pops up.
2. If you are aware of the page number you want to locate, select the Goto Page option and 

set the number in the Page Number text box.
3. If you want to find the photo with a specific text string in its Information option, select 

the Find Page option.
In the From text box, set the page number you want to start searching the photo.
In the Search String text box, type in the text string you want to use for searching the 
photo.
In the Direction option, select you want to search the pages before or after the page you 
have specified in the From text box.

4. Click on [OK].



Wall Paper

An album page can be used as the wall paper of Windows desktop background. Open the 
Page menu and select the Wall Paper command.



Background Music

When you want to assign a special music for the current page, select the Background Music 
command from the Page menu. When a dialog box pops up, select a music file to attach with
the page.



Photo Menu

The Photo menu contains the following commands for editing photos or objects:
Cut
Copy
Paste
Duplicate
Delete
Clear Photo
Photo Tuning
Bring to Top
Send to Back
Move Forward
Move Backward
Properties



Cut

The Cut command removes an object (a photo or object) and places it on the Windows 
clipboard. You can use the Paste command to place the object last cut and put on the 
clipboard back onto the album, or paste it in another application. Only the last cut content 
resides in the clipboard. To cut an object. do the following:
1. Select the object you want to remove and place on the Windows clipboard.
2. Open the Photo menu and click on the Cut command. The select object is removed.
Note:

The keyboard shortcut to execute the Cut command is [Ctrl]+[X].



Copy (Photo)

The Copy function enables you to make a copy of the selected object and place it on the 
Windows clipboard. The original object is unaffected by the Copy command. You could use 
the Paste command to move the object last copied on the clipboard to the same or another 
page. Only the last copied object resides in the clipboard. To copy a page:
1. Select the object you want to copy.
2. Open the Photo menu, and click on the Copy command. A copy of the selected object 

then resides in the clipboard.
Note:

The keyboard shortcut for copying the image is [Ctrl]+[C].



Paste

The Paste command pastes the content which was last cut or copied to the clipboard onto 
the current page. The command works only when there is already a content in the clipboard.
To paste, do the following:
1. Open the Photo menu, and click on the Paste command.

A selection outline appears containing the content of the clipboard.
2. Move the pointer into the selection outline.
3. Drag the pasted object to the location on the page where you want to place the object.
4. Click the left mouse button outside of the selection outline to paste the object.
Note:

The keyboard shortcut to execute the Paste command is [Ctrl] + [V].



Duplicate

The Duplicate function enables you to reproduce the selected object on current page. To 
execute the Duplicate command, first select the object you want to duplicate, and then open
the Photo menu and click on the Duplicate command.



Delete (Photo)

The Delete command permanently removes the selected object. To execute the Delete 
command, first select the object you want to remove, and then open the Photo menu and 
click on the Delete command.



Clear Photo

The Clear Photo command removes the photo from the current selected frame.



Photo Tuning

The Photo Tuning dialog box provides you with a preview mode to adjust dark, midtone and 
light areas of a photo in hue or brightness/contrast. It enables your instant comparison 
between the original colors and the result of changes you may make on it.
To fine tune the colors of a photo:
1. Select the Photo Tuning command from the Photo menu. The Photo Tuning dialog box 

appears.
In the left portion of the Photo Tuning window, you have eight photo previews showing 
different effects of hue and brightness adjustments. Among them, the sample image in 
the middle represents your current selection taken from the eight surrounding 
possibilities. Before the first selection from the surrounding previews, the middle image 
shows the shrunken copy of the original photo.
The six previews at the top and bottom rows of the sample image reflect the hue 
adjustments to the middle photo; the two previews at the left and right of the sample 
photo show brightness adjustments.

2. Drag the vertical slider at the lower right of the dialog box to define the adjustment level 
as a slight or more pronounced adjustment.
Your setting will be immediately reflected on the left side previews.

3. Click on the preview (among the eight) which best satisfies your need. The selected 
preview will move into the middle position, and the surrounding previews will change 
according to the new sample.

Note:

You may recall the original photo as the sample image by clicking on the [Reset] button at 
the bottom of the dialog box.

4. The default setting for the area to be changed in the photo is Full, which means changes 
to the whole photo. If you want to change only the light, midtone, or dark area in the 
photo, click to select the Highlights, Midtones, or Shadows option respectively.

5. If you want to change the photo’s brightness and contrast, click on the 
Brightness/Contrast option. The three top photo previews reflect the effects of enhancing
contrast, and the three bottom ones the effects of reducing contrast. The three left photo
previews reflect the effects of decreasing brightness, and the three right ones the effects
of increasing brightness. Use the same procedure as in Steps 2 and 3 to adjust the 
brightness/contrast of the photo.

6. After you obtain a satisfying sample image, click on the [OK] button to start the process 
of adjustment, or click on [Cancel] to abandon the process.



Bring to Top

When two or more photos or objects are placed overlapped on a page, Bring to Top moves 
the selected photo to the very top of all the overlapping photos.

Related Topics:

Send to Back
Move Forward
Move Backward



Send to Back

When two or more photos or objects are placed overlapped on a page, Send to Back moves 
the selected photo to the very bottom of all the overlapping photos.

Related Topics:

Bring to Top
Move Forward
Move Backward



Move Forward

When two or more photos or objects are placed overlapped on a page, Move Forward places 
the selected photo over the one that is currently on top of it.

Related Topics:

Bring to Top
Send to Back
Move Backward



Move Backward

When two or more photos or objects are placed overlapped on a page, Move Backward 
places the selected photo under the one that is currently at the lower level of it.

Related Topics:

Bring to Top
Send to Back
Move Forward



Properties

The Photo Info dialog box invoked by the Properties command under the Photo menu allows 
you to enter text about the photo or assign a linking action for the photo as well as add 
sound or music.
1. To add some music to the photo so that a background music can be played if you click 

the photo while enjoying the album, click on the Music  button.
A dialog box appears for selecting a wave or midi file to attach to the photo. Locate the 
file and click on [OK] to attach the music.

2. If you want to record some sound effects or a narration about the photo, click on the 

Record  button. When the Audio Format dialog box appears, set the sound elements 
for the format of your sound file.
After you click [OK], you may start to record with your microphone. When you finish 
recording, click the Record button again to stop recording.

You may click the Play  button to listen to the result of recording.
3. In the Link section, you may define an action of turning the page when the photo is 

clicked by the user. If the photo is clicked when the album is played back, it can be set to
turn the page to the first, last, next, previous or a specific page. Enable the Link Page 
option and select the page control button to define the action or drag the slider at the 
right to set the page number you want to go to.

4. In the Photo Information option, type in the content you want to specify about the photo, 
i.e. the time taking the picture, the place and the event.

5. Click the [OK] button to save the properties.



View Menu

The commands provided under the View menu are related to the display on the editing 
screen. They are:
Full Screen
Hide All
Photo Browser
Toolbox
Object Pool
Status Bar
Menu and Title



Full Screen

When you select the Full Screen command in the View menu, the album page will be 
enlarged to the entire screen for clear observation of the editing effect, and all other screen 
elements will be hidden. Press the [Esc] key once to restore the editing screen.



Hide All

To hide all the palette windows on the editing screen, including the Photo Browser, Object 
Pool, Toolbox and status bar, open the View menu and select Hide All, or press the [Tab] key.
When a check mark appears at the left of the command, the palette windows is hidden.



Photo Browser

This command decides whether to display the Photo Browser. When a check mark appears 
at the left of the command, the Photo Browser is displayed.

Pressing the  button on the status bar is equivalent to executing this command.



Toolbox

This command decides whether to display the Toolbox. When a check mark appears at the 
left of the command, the Toolbox is displayed.

Pressing the  button on the status bar is equivalent to executing this command.



Object Pool

This command decides whether to display the Object Pool. When a check mark appears at 
the left of the command, the Object Pool is displayed.

Pressing the  button on the status bar is equivalent to executing this command.



Status Bar

This command decides whether to display the Status Bar. When a check mark appears at the
left of the command, the Status Bar is displayed.



Menu and Title

The Menu And Title command in the View menu can hide or display the title bar and menu 
bar on the screen at once. This function is the same as clicking the button located at the left 
of the status bar.
When a check mark appears at the left of the command, the title bar and menu bar are 
displayed.



Help Menu

Besides the messages shown on the status bar, select the Help menu for more information 
on any of the functions, commands and dialog boxes.



Loading the Photos

The Photo Browser can display thumbnail copies of the photos, with their filenames, that you
want to place into the album.

Commands Click this button to bring up several commands for inputting photos, 
opening photos, setting the photo display options, etc.

Recent Folders Click the down arrow to display a list of folders that were recently used 
in Photo Browser.

Photo Viewer Display the thumbnail copies of the photos included in the selected 
folder.

Change Directory Locate a new directory to load the photos for editing.
Acquire Input photos with a TWAIN hardware device.
Scroll Buttons Scroll through upper or lower part in the Photo Viewer to display the 

photo thumbnails that are not currently visible.

The following commands are listed in the pop-up menu when the Commands button is 
clicked.
Hide
Option
Change Directory
Refresh



Select TWAIN Source
Acquire
Photo



Hide (Photo Browser)

The Hide command removes the Photo Browser from the screen.

To display the Photo Browser again, click the  button on the status bar, or select the 
Photo Browser command from the View menu.



Option

The Option dialog box contains several options for setting the preferences on the functions 
performed in Photo Browser.

Number of Recently Visited Directories
This option sets the number of folders the software can recall (9 in maximum) in the Recent 
Folders pull-down list.
Photo Editing Program
A photo loaded in the Photo Viewer can be opened in an image processing software for 
further editing. This option specifies the software you want to use for editing the photos. If 
no specific program is selected, the system will decide an appropriate one for you.
Type in the execution file of the specific software with its path or click the [Browse] button to
select it from a dialog box.
Default Saved Name After TWAIN Acquired
You may input photos from a digital camera or scanner supporting TWAIN interface installed 
on your system. If your TWAIN device is capable enough, you can input multiple photos at 
one time.
In this option, type in the first few characters for the file names of the new input photos and 
select the file format from the pull-down list.
The file names will automatically be assigned with 3-digit numbers after the first few 
characters.
For some of the file formats, you may click on the [Option] button to further specify their 
format options.
Apply Auto-tuning Before Saving
If you want the software to correct the colors of the input photos, enable this option.

Related Topic:

Acquiring Photos



Change Directory

If you have gathered all the photos you want to insert into the album in a specific folder or 
directory, you can load them into the Photo Viewer of Photo Browser to see their thumbnail 
copies and insert them into the album.
If the folder or directory has recently been located in Photo Browser, click the down arrow of 
the Recent Folders pull-down list to recall it. If not, select the Change Directory command or 
click the Change Directory button to invoke a dialog box for locating it.



Refresh

Whenever you invoke the Photo Browser and locate the directory you want to view photo 
files, the thumbnail photo previews are displayed according to the current file access 
situation in the directory. If you change the situation after the directory is explored, i.e. 
adding or removing some files to/from the directory, and do not refresh the information for 
the program, the thumbnails displayed will not reflect the latest changes. In this case you 
should execute the Refresh command in the Commands menu to update the modification.



Select TWAIN Source

This software supports the TWAIN driver interface to give you access to images from any 
input device with a TWAIN driver interface such as digital cameras and scanners. As long as 
the input device provides a TWAIN driver, it can work with the software without any problem.
Before you want to actually input photos with a digital camera or scanner, you should install 
it with Windows 95 by referring to its installation manual.
Before inputting any photo from your TWAIN device, you should select the TWAIN device 
used for inputting photos in your system.
1. Open the Commands menu and select the Select TWAIN Source command. A dialog box 

appears with all the TWAIN sources installed on your system listed in the Sources box.
2. From the list of the TWAIN devices, select the one you want to use and click on the 

[Select] button.

Related Topics:

Acquire
Acquiring Photos



Acquire

To acquire image input from a TWAIN source, open the File menu and select the Acquire 
command after selecting the TWAIN source. A dialog box will appear for your further 
operation. The dialog box varies for different devices because manufacturers design their 
own user interface.

Related Topics:

Select TWAIN Source
Acquiring Photos



Photo

The Photo command provides three options for editing a selected photo. This command is 
available only when there is a thumbnail copy of photo currently selected.

Open With
A photo loaded in the Photo Viewer can be opened in an image processing software for 
further editing. To open a photo, you may execute this option, or double click on the 
thumbnail copy of the selected photo.

Delete
This option deletes the selected photo.

Properties
This option displays the information about the selected photo.



Using the Tools

The tools in the Toolbox enable you to make simple artwork for decoration of the album.

      Selection Arrow  

      Object Tool  

      Paintbrush  

      Text  

      Text Along Path  



Selection Arrow

The Selection Arrow allows you to select an object and move the object to another location 
on the pages. An object indicates an ornament or photo with its frame and shadow (if any). 
You may select an object for further editing actions such as copy, duplicate, delete, etc. or 
change its shadow style, resize it, rotate it, and so on.
To select an object, click on the Selection Arrow icon in the Toolbox, move the mouse pointer 
to the object you want to select and click. A dotted outline will appear around the object. 
Click anywhere empty on the page to deselect an object.
To move an object, place the mouse pointer into a selected object and drag it to the desired 
position.



Object Tool

The Object tool allows you to resize and rotate an object on the page. Whenever an object is 
selected, the changes made will be applied to itself and anything attached to it, such as a 
frame and shadow, at the same time.
You can also move the selected object by dragging it inside the object while using the Object
tool.
To use the Object tool:
1. Select the object you want to resize or rotate with the Selection Arrow.
2. Select the Object tool in the Toolbox. A rectangle with a right handle surrounding by 

totally nine small square nodes appears around the object.
3. If you want to resize the object, place the mouse pointer to any of the eight nodes on the

rectangle and drag to the direction you want to expand the object.
4. If you want to rotate the object, drag the node on the right handle to the direction you 

want to rotate the object. Press and hold the [Shift] key while dragging the mouse to 
rotate it by 45 degree increments.

5. After you select another object or tool, the rectangle and rotating handle will be 
removed.



Paintbrush

This tool allows to draw lines free-handily as if you were drawing with a real paintbrush.
To draw with the paintbrush:
1. Click on the Paintbrush tool.
2. Double click the tool icon to invoke a dialog box for setting the options of the Paintbrush.

Specify the size and color of the paintbrush. Drag the Size slider to set the brush size. 
Click inside the color block to change the color in the pop-up dialog box.

3. Place the mouse pointer to the point you want to start tracing your line.
4. Press and hold the left mouse button.
5. Drag the mouse pointer along the line path you want. The line appears along the cursor 

path as you drag.
6. Release the mouse button where you want the line to end.



Text

You can enter text anywhere on a page with the Text tool. The software supports all the fonts
installed in Windows 95.
The Text tool provides options for selecting fonts, font styles, and character sizes. After 
inputting text, you can reshape it by changing its dimensions.
To enter the text:
1. Click on the Text tool.
2. Move the cursor to where you want the text to start and click. A Font dialog box appears.
3. Select the font, the font style, and the character size. The Sample box will display an 

example of the selection you made.
4. In the Effects window, select the color for the text in the Color option. Click inside the 

color block to invoke a dialog box for selecting color.
5. If you want the text character to be placed vertically, enable the Portrait option.
6. Enter the text in the Text box.
7. Click on [OK] to input the text.
8. A rectangle with eight square nodes around the text appears on the page. Drag the 

nodes to change the shape and size of the text.
Note:

Hold the [Shift] key while dragging the nodes on the corners to resize the rectangle as 
square.

9. Double click the mouse button to fix the text shape.
The text will be automatically selected for your further editing. It can be considered as an 
object for all editing actions.



Text Along Path

The Text Along Path tool allows you to insert text on the page and place the text along a 
defined curve path. To complete this effect, you must define a curve path and adjust the text
position along the path.
To generate text along path:
1. Select the Text Along Path tool.
2. Move the cursor to where you want the text to start and click.
3. When the Font dialog box appears, enter the text as you would do when using the Text 

tool.
4. Select the text to be placed vertically (upright) or rotated according to the curve path in 

the Effect option.
5. Click on [OK] to close the dialog box.
6. Place the mouse pointer to where you want to start drawing your path.
7. Click the left mouse button to set the beginning of the path. Do not release the mouse 

button.
8. Drag the mouse pointer in the direction you want the curve drawn. As you drag, two 

control points appear and move in opposite directions from the node. The distance 
between the control points and the node determines the height or depth of the curve. 
The angle of the control points determines the curve’s slope.

9. When the control points are in the desired position, release the mouse button.
10.Repeat step 7 to set the other end of the first curve segment you want to create. A 

second node appears and connected to the first.
11.Drag to generate two control points for this node.
12.Release the mouse button. You may drag the nodes and control points to adjust the 

shape of your curve segment.
If you did not drag from the nodes to generate control points in previous steps, you may 
hold the [Shift] key and drag from the nodes to create control points anytime.

13.Click and drag the pointer outside the nodes and control points to form another adjacent 
segment of curve linking with the first one. Repeat steps 10 through 12 to complete all 
the segments in the curve you want to create.
Before fixing the curve segments, you can click on any node to activate the control 
points of the curve segment connected and adjust the curve.
To remove the last node generated, hold the [Ctrl] key and click the left mouse button.
If you want to create a closed area with the curve segments, hold [Shift] and click the 
right mouse button to generate a new segment connecting from the last node to the first
one.

14.When you are satisfied with the shape of your curve, double click the mouse button to fix
the curve.

Note:

If you did not drag to generate control points for the nodes, the drawing will become a 



straight line. Hence you can use this tool to produce adjacent segments of straight lines.

The text will be automatically selected along the path you defined for further editing. It can 
be considered as an object for all editing actions.



Decorating the Album

The Object Pool allows you to select frame style, special effect, ornament and texture to the 
pages for decoration. The buttons lined up horizontally are the categories available for each 
item.
Frame
Effect
Ornament
Texture



Adding Frames to the Album

Presto! PhotoAlbum provides various frame styles with different colors and shapes for adding
into the album to hold the photos. The frame style you select will be applied to the pages in 
size and position according to the book style of the album.
Once you have inserted a frame onto the page, you can move, resize and rotate it with the 
photo it holds by the tools in the Toolbox. Look for the section Using the Tools for details.
If you have selected a predefined album format, you may change the frame style for 
individual page. If you have defined a totally new album through the CUSTOM button, you 
should add frames into the pages before inserting any photo.
To add frames to the pages:
1. Turn to the page you want to apply or change the frame style with the page control 

buttons on the status bar.
2. Click on the Frame button in the Object Pool.
3. Select the frame category from the row of category buttons, which contains the frame 

style you want to use.
4. Decide the frame style you want to use.
5. Drag the frame icon inside the page and release the mouse button where you want to 

place the frame.



Adding Effects to an Object

In Presto! PhotoAlbum, you may create various special effects of photo processing to a 
selected object by using the Effect function in the Object Pool. The special effects are 
categorized as follows:
Shadow
Transparency



Shadow

You may create shadow for a photo or ornament object with selection of different depth. 
Once the shadow is generated, it is attached to the object; that is, any change to the object 
also takes effect to the shadow.
To create shadow effect for an object:
1. Select the object you want to apply shadow with the Selection Arrow.
2. Click on the Effect button in the Object Pool.
3. Select the Shadow button from the row of category buttons.
4. Decide the depth you want to use for the object.
5. Drag the selected icon into the object and release the mouse button.
To remove the shadow of an object:
1. Select the object whose shadow you want to remove.
2. Click on the Effect button in the Object Pool.
3. Click on the Shadow button from the row of category buttons.
4. Select the first shadow icon (the one without shadow depth).
5. Drag the selected icon into the object and release the mouse button.



Transparency

The photos, ornaments and drawn objects on the album pages can be applied with different 
percentages of transparency to mix with its background.
To create transparency effect for an object:
1. Select the object you want to apply transparency with the Selection Arrow.
2. Click on the Effect button in the Object Pool.
3. Select the Transparency button from the row of category buttons.
4. Decide the transparent percentage needed for the object.
5. Drag the selected icon into the object and release the mouse button.
To remove the transparency of an object:
1. Select the object whose transparency you want to remove.
2. Click on the Effect button in the Object Pool.
3. Click on the Transparency button from the row of category buttons.
4. Select transparent percentage icon (0%).
5. Drag the selected icon into the object and release the mouse button.



Adding Ornaments to the Pages

Presto! PhotoAlbum provides plenty of ornament objects with various categories for page 
decoration. You may choose the ornaments according to the content of your photos.
An ornament object can be placed anywhere on the pages and be resized or rotated by the 
tools in the Toolbox.
To add an ornament object to the page:
1. Turn to the page you want to add the ornament object with the page control buttons on 

the status bar.
2. Click on the Ornament button in the Object Pool.
3. Select the ornament category from the row of category buttons, which contains the 

ornament object you want to use.
4. Decide the ornament you want to use.
5. Drag the ornament object icon into the page and release the mouse button where you 

want to place the object.



Selecting Texture for the Page

The software can coat the page surface by a specified texture pattern, which produces an 
outlook as if it were made up with that specific material.
Once you apply texture patterns to the pages, the texture patterns will not be removed 
when you clear the objects on the pages.
To apply a texture pattern:
1. Turn to the page you want to apply or change the texture pattern with the page control 

buttons on the status bar.
2. Click on the Texture button in the Object Pool.
3. Select the texture category from the row of category buttons, which contains the texture 

pattern you want to use.
4. Decide the texture pattern you want to use for the pages.
5. Drag the texture icon inside the page and release the mouse button.
If you drag the texture icon to the desktop area outside the album page, the texture will be 
applied to the entire desktop as the background of the album.
You can also apply the texture to an object generated by the Paintbrush, Text and Text Along
Path tools. All you need to do is to select the object and drag the desired texture icon into it.



Enjoying an Album

When enjoying an album, you can not only view the photos in the album but also listen to 
any background music or recorded narration attached to the album, pages and photos.
To enjoy an album:
1. In the opening screen, click on the VIEW button.
2. When the Select an Album dialog box appears, locate the album you want to enjoy.
3. Click on the [OK] button.
The album will be played back after a moment.



Operation in Playback Screen

When enjoying an album, you can not only view the photos in the album but also listen to 
any background music or recorded narration attached to the album, pages and photos.
The control bar will be displayed when you move the mouse pointer to the bottom of the 
screen.
Click on the Preferences button to arouse a dialog box for setting the playback options.
The page control buttons can locate the page you want. If you press and hold the left mouse 
button on the Previous Page or Next Page button for a while, the page number field at the 
right will keep on counting until you have reached the page you want and released the 
mouse button. Therefore you can select to display a specific page immediately without 
displaying the pages in-between. Click on the Play/Stop button to start or stop playing the 
pages.
The Print button allows you to print the current page immediately with normal resolution. 
Clicking the Set Wall Paper button sets the current page as Windows desktop background.
The Quit button allows you to exit the playback program.
When you place the mouse pointer on a photo in the album page, if the pointer changes to 
the shape of a speaker, it means there is a sound file attached to the photo. Click the right 
mouse button to play it. If the pointer changes to the shape of linking rings, that means the 
photo is linked to a specific page. Click the left mouse button to go to the specific page. If 
the pointer contains both the speaker and the linking rings, you may select to click the left 
or right mouse button as desired.
The annotation for each photo will be displayed in a pop-up balloon if you move the mouse 
pointer into the photo and stay awhile.



Playback Preferences

When you click the Preferences button or press the [Enter] key, the following dialog box will 
pop up for your setting on playing back the album.

Full Screen Display
This option can enlarge the display of album page to the screen size.

Mute
Enabling this option disables the three options in the Slide Show section: Enable Background
Music and Enable Photo Audio. All the sound effect will be disabled while playing back the 
album.

Auto Play on Opening
If this option is enabled, the selected album will be automatically played back next time 
when you arouse the playback program.
Display Tooltips for Buttons
This option turns on or off the display of on-screen tool tips for illustrating the button 
functions.

Display Photo Annotation
This option turns on or off the display of pop-up balloons containing photo annotation.

Enable Background Music
This option determines whether to play any background music assigned to the album pages.

Enable Photo Audio
This option determines whether to play any audio attached to the photos.

Auto Replay
When this option is on, the playback program will continue to play from the beginning after 
you have reached the last page.
Page Flipping Every
This option sets the interval between two pages by seconds while playing back the album.
Save as Default
Click this button to save the current setting as default. Usually the program will use the 
default setting for operation. The specified options will be loaded when you open the 
Preferences dialog box again. If you have changed the setting and select [OK], the altered 
setting will take effect temporarily. The default setting will be in charge next time you arouse
the playback program.



Sharing the Album on Internet

If you want to share the album with others through Internet, you should place all the files 
needed for enjoying the album to where you can share with other users.
Copy the entire folder generated by the For Internet option of    Deliver command under the 
Album menu to where you can share with other users on Internet. Other users can enjoy the 
album with the file DEFAULT.HTM (or VIEWER.HTM) by using a network browser as Internet 
Explorer V3.0 or Netscape Navigator V3.0 (or later).



Acquiring Photos

To input photos in Presto! PhotoAlbum from a TWAIN hardware device:
1. Use the Change Directory button to locate the directory used to hold the new input 

photos.
2. Click the Commands button and choose the Option command from the pop-up menu. The

Option dialog box appears.
3. In the Default Saved Name After TWAIN Acquired option, type in the first few characters 

for the file names of the new input photos and select the file format from the pull-down 
list.
The file names will automatically be assigned with 3-digit numbers after the first few 
characters.
For some of the file formats, you may click on the [Option] button to further specify their 
format options.

4. If you want the software to correct the colors of the input photos, enable the Apply Auto-
tuning Before Saving option.

5. Click on [OK] to close the dialog box.
6. Open the Commands menu and select the Select TWAIN Source command. A dialog box 

appears with all the TWAIN sources installed on your system listed in the Sources box.
7. From the list of the TWAIN devices, select the one you want to use and click on the 

[Select] button.
8. Open the Commands menu again and select the Acquire command.

A dialog box will appear. The dialog box varies for different devices because 
manufacturers design their own user interface. You may refer to the user’s manual of the 
TWAIN device for details on inputting images from this dialog box.

After the input process is done, the thumbnail copies of the new photos appear in the Photo 
Viewer area for your further editing.

Related Topics:

Option
Select TWAIN Source
Acquire
Loading the Photos



Adding Photos to the Pages

The only way to add photos into the pages is to drag the thumbnail copies of the photos in 
the Photo Viewer into the frames on the pages. Therefore, you should add frames into the 
pages before inserting the photos.
If you did not add a frame to the album page before inserting a photo, the software will 
automatically add a plain rectangle frame fitting the photo dimensions to hold the photo.
The photo in a frame can be changed to another any time as long as you drag another photo
from the Photo Viewer into the frame.
To add a photo into the frame:
1. Select the frame you want to use to hold the photo with the Selection Arrow.
2. Locate the photo for inserting into the frame in the Photo Viewer of Photo Browser.
3. Drag the thumbnail copy of the photo into the frame.
4. Release the mouse button.
The blank background between the photo and frame can be removed by automatically 
resizing the frame to fit the photo dimensions. To adjust the frame dimensions to fit the 
photo size, you should first select the photo, then click the right mouse button and execute 
the Make Matching Frame command from the pop-up menu.
Related Topics:

Adding Frames to the Album
Selection Arrow
Put All Photos



Defining Linking Feature for Objects

Besides the photos inserted into the album, all the ornaments and drawn objects can also be
assigned for linking a specific page.
You may define the linking feature for photos, ornaments and drawn objects, so the specified
page will be displayed when the object is clicked during the playback process.
1. Select the object you want to assign a linking page.
2. Click the right mouse button and select Properties from the pop-up menu.
3. Enable the Link Page option.
4. Drag the slider to set the page number, or click on a page control button to choose the 

first, previous, next or last page for linking.
5. Click on the [OK] button.



Utilizing Your Own Pictures as Ornaments

If you want to utilize a picture made by yourself for using as an ornament object, please note
the following instructions:
1. Make the four pixels (arranged as a 2x2 pixel square) at the upper left corner of your 

picture the same color as the background you want to make transparent for transforming
the object in the picture an ornament clipart while producing it.

2. Locate the picture in the Photo Browser and load it into the Photo Viewer.
3. Hold the [Ctrl] key and drag the picture thumbnail into the page.
4. Release the mouse button outside the frame(s).
The background color in the picture will become transparent after you have inserted the 
picture to the page. The added clipart can be edited as a general ornament object.



Generating Your Own Template

Besides the sample albums and the existing albums, you can generate your favorite album 
template for producing new albums. For example, you may use one of the page you like in 
an existing album to create a separate album template and use the format of that page for 
the entire new album, or make a totally new album and use its format as an album template.
If you want to use one or several page(s) in an album for generating a new template, you 
may follow these steps:
1. Open the album containing the page(s) you would like to utilize for a new template.
2. In the editing screen, delete other pages you don’t need for the new template by the 

Delete Page command in the Page menu.
3. Save the album with a new name by the Save As command under the Album menu.
4. Return to the opening screen by selecting the Restart command in the Album menu.
5. Select the CREATE button for producing a new album.
6. Select the TEMPLATE button and locate the new album you have saved in step 3.
7. After the album template is loaded into the editing screen, make any change necessary 

to the pages.
8. Use the commands in the Page menu to rearrange the pages in the album. For example, 

you may duplicate the pages with different formats as you like, change the sequence of 
pages with different formats, etc.

9. Save the album again.
If you want to generate a totally new album and utilize its format for a template, please 
follow these steps:
1. Select the CREATE button for producing a new album in the opening screen.
2. Select the CUSTOM button and define the book and ring styles for the new album.
3. After the album is created in the editing screen, add all the elements you like to compose

the page, including frames, effects, ornaments, texture, etc.
4. Create as many pages of different formats as you want to use for the album template.
5. Use the commands in the Page menu to rearrange the pages in the album. For example, 

you may duplicate the pages with different formats as you like, change the sequence of 
pages with different formats, etc.

6. Save the album with a new name by the Save As command under the Album menu.
On the next time you want to use this album template, you only need to select this new 
album for opening as an album template by clicking the CREATE button and then the 
TEMPLATE button in the opening screen.



 EXIT

Click on this button to quit the software.



 EDIT

Click on this button to load a pre-existing album.



 CREATE

Click on this button to create a new album.



VIEW

Click on this button to enjoy an album.



HELP

Click on this button to invoke the on-line help message.



Sound Effect Button

Click on this button to turn on or off the sound effect of program operation.



 PREVIOUS

Click on this button to return to last screen.



 TEMPLATE

Click on this button to use a pre-existing album format for your new album.



 CUSTOM

Click on this button to define the album with totally new format.



Title Bar



Menu Bar



 Toolbox



 Album Page



 Object Pool



 Photo Browser



Menu Bar and Title Bar On/Off Button

Click on this button to hide or show the menu bar and title bar.



 Message Line



 Status Bar



 Photo Browser Button

Click on this button to hide or show the Photo Browser.



 Object Pool Button

Click on this button to hide or show the Object Pool



 Toolbox Button

Click on this button to hide or show the Toolbox.



 Current Page Number/Total Pages in the Album



 Go to the Cover Page



 Go to the Previous Page



 Go to the Next Page



 Go to the Last Page



 Go to Any Page You Specify



 Commands Button



Recent Folders



 Change Directory



 Acquire



 Photo Viewer



 Scroll Button



 Menus and Commands

There are several pull-down menus located on the menu bar. Each menu contains a list of 
commands to execute special functions for image processing.
Choose a menu from the following list to view the command function under it.

Album
Page
Photo
View
Help



 Using the Tools

The tools in the Toolbox enable you to make simple artwork for decoration of the album.

       Selection Arrow  

       Object Tool  

       Paintbrush  

       Text  

       Text Along Path  



 Decorating the Album

The Object Pool allows you to select frame style, special effect, ornament and texture to the 
pages for decoration. The buttons lined up horizontally are the categories available for each 
item.
Frame
Effect
Ornament
Texture



 Loading the Photos

The Photo Browser can display thumbnail copies of the photos, with their filenames, that you
want to place into the album.

Commands Click this button to bring up several commands for inputting photos, 
opening photos, setting the photo display options, etc.

Recent Folders Click the down arrow to display a list of folders that were recently used 
in Photo Browser.

Photo Viewer Display the thumbnail copies of the photos included in the selected 
folder.

Change Directory Locate a new directory to load the photos for editing.
Acquire Input photos with a TWAIN hardware device.
Scroll Buttons Scroll through upper or lower part in the Photo Viewer to display the 

photo thumbnails that are not currently visible.

The following commands are listed in the pop-up menu when the Commands button is 
clicked.
Hide
Option
Change Directory
Refresh



Select TWAIN Source
Acquire
Photo



Quick Linking

A shortcut button for quick linking is now added at the right bottom of the screen. It lets you link fast into 
the web site of NewSoft company, and automatically launch into any NewSoft's software that you already 
have in your computer.        



Mailing the HTML Files Directly

If you choose the For Internet option under the Deliver command for sending the album, the files of the 
album can now be directly mailed right after formated. A dialog box pops up when you finish converting 
the album into HTML format. When you choose the [OK] button, the HTML files will be packed into a .exe 
file for mailing. Please refer to the Delivering the Album by E-mail section for detailed operation on 
sending an album by e-mail.    



Delivering the Album by E-mail

After an album is finished, you may share it with your friends and family by e-mail. Presto! PhotoAlbum 
lets you convert an album that has been saved in HTML format, into exe file format for e-mail attachment. 
To deliver an album:

1. Choose Deliver from the Album menu.

2. Choose the By E-mail option from the pop-up sub-menu.

3. When the Choose Directory dialog box appears, locate the directory where the previously formatted 
HTML files of the album are stored on.

4. Click the [OK] button.

5. A MailPack dialog box pops up. Choose an electronic mail system you are familiar with, or choose the
Save option to pack your album files for another similar application.

6. Click the [OK] button

The E-mail system you selected will be launched automatically, and your album packed as an exe file will 
also be attached in it. After you have finished the document, send it. Double clicking on the attached file, 
the recipient can enjoy your album without any file format problem.




